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Abstract. The purpose of this work was to develop a phytobioassay algorithm including the automated 
measurement of plant morphometric parameters and primary data processing using the ImageJ software. 
The objects of the study were pictures of 7-day Trifolium pratense L. clover seedlings exposed to short-
term (7 days) copper chloride solutions (5, 10 and 15 mg/L in terms of copper (II) ions) and pictures of the 
subflag leaf of Hordeum vulgare L. barley grown in soil contaminated with cadmium (19.2 ± 1.5 mg/kg) 
for 60 days. The experiments were performed in 3 replicates with n = 20. An algorithm for working with 
the pictures, including such steps as dividing a photo into color channels and image segmentation up 
to excluding 5% of extreme sample values, was proposed. In acute tests on T. pratense, the standard 
deviation (SD) made up 5–11% when measuring the length of roots and 3–7% for sprouts. In chronic 
experiments on H. vulgare, SD for linear parameters (leaf length and width) fluctuated from 11 to 21% and 
reached 33% for the leaf area. Conclusions were made about the suitability of the proposed algorithm 
for assessing acute phytotoxicity and the need to refine the methodological and statistical aspects 
of chronic phytotests. The main advantages of phytobioassay with data collection and processing in 
ImageJ are the possibility of delayed measurements of phytoobjects from a photo and assessment of 
the parameters of geometrically complex objects.
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Автоматизированный сбор массива данных 
в острых и хронических фитотестах

Вятский государственный университет, 610000, Россия, г. Киров, ул. Московская, д. 36

*morgan-abend@mail.ru

Аннотация. Целью данной работы была разработка алгоритма фитотестирования, включающего 
автоматизированное измерение морфометрических параметров растений и первичную обработку 
данных средствами программы ImageJ. Материалами исследований служили фотоснимки 7-дневных 
проростков клевера (Trifolium pratense L.), подвергшихся краткосрочному воздействию (7 суток) 
хлорида меди в растворе (5, 10 и 15 мг/л в пересчете на ионы меди (II)), и фотоснимки подфлагового 
листа ячменя (Hordeum vulgare L.), выращенного в почве, загрязненной кадмием (19.2 ± 1.5 мг/кг) 
в течение 60 суток. Опыты выполнены в трехкратной повторности, n = 20. Предложен алгоритм 
работы с фотоснимками: от разделения снимка на цветовые каналы и сегментации изображения 
до исключения 5% экстремальных значений выборки. В острых испытаниях на T. pratense показано, 
что стандартное отклонение среднего составляет 5–11% при измерении длины корней, 3–7% – 
ростков. В хронических опытах на H. vulgare стандартные отклонения колебались от 11 до 21% 
для линейных показателей и достигали 33% для площади листа. Сделаны выводы о пригодности 
предложенного алгоритма для оценки острой фитотоксичности и необходимости доработки 
методических и статистических аспектов хронических фитотестов. Главными преимуществами 
фитотестирования со сбором и обработкой данных в ImageJ являются возможность отсроченных 
измерений фитообъектов по фото и оценка параметров геометрически сложных объектов.

Ключевые слова: биотестирование, Image, ImageJ, тяжелые металлы, токсичность, обработка 
биологических данных
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Introduction
Computer vision (CV) is currently replacing direct measurement methods of environmental objects 

with information extracted from photographs and videos (Olkova and Medvedeva, 2023). CV can 
increase the amount of acquired and processed data, as well as the number of measurable parameters. 
The method eliminates subjective assessments of biological objects, reduces research costs, and 
facilitates the development of new biomonitoring methods. CV enables the rapid, accurate, and reliable 
acquisition of environmental data (Lopez-Marcano et al., 2021).

Automation has recently become a key driver of methodological development in bioassay, bioindication, 
and environmental monitoring (Olkova and Tovstik, 2024). It is particularly important in phytotoxicity 
testing because the majority of existing methods (GOST R ISO 18763-20191, FR.1.31.2012.115602, MP 
2.1.7.2297-073) suggests using a ruler as the main measurement tool. However, manual measurement 
of plant growth parameters is not only labor-intensive but also prone to inaccuracies due to the complex 
objects geometry (Fiskesjö, 1985).

Global practice has accumulated experience in the automated assessment of plant morphological 
parameters for use in bioassay and bioindication (Li et al., 2020; Železnikar et al., 2025). However, 
specialized software products are often expensive and subject to copyright restrictions. ImageJ and its 
version, ImageJ Fiji, offer significant advantages in this regard: they are open source and do not infringe 
copyright.

ImageJ is JAVA image processing software that has become an essential tool for scientific research 
in natural sciences (Curtis et al., 2017). It is known for its extensibility via plugins. Users can create new 
plugins or record macros to customize the program's option for specific purposes (Kainz et al., 2015).

For decades, ImageJ has been a pioneer as an open-source scientific image analysis software 
(Schneider et al., 2012). A search for "ImageJ" in the ScienceDirect database with "natural sciences" filter 
yields around 14 thousand results between 2014 and 2024. Approximately 1000 of these publications 
belong to "phytotoxicity testing" specification. Furthermore, root length estimates obtained with ImageJ 
and commercial root measuring software WinRHIZO showed a high-accuracy correlation (r = 0.986) 
(Tajima and Kato, 2011). 

However, further information analysis revealed the absence of specific methodology for phytotoxicity 
testing using ImageJ tools. Leaf length and its fractal dimension turned to be a good indicator of plant 
responses to environmental toxicants (Bialowiec et al., 2010). In a study of C. Eichberg et al. (2024), the 
phytotoxicity of antibiotics was assessed based on the responses of Carum carvi L., Centaurea jacea L., 
Dactylis glomerata L., and Silene latifolia (Poir.). Germination was determined visually, roots length of 
7-day-old seedlings were measured using ImageJ tools by 5 (average 3.0 ± 1.7) out of 50 randomly 
selected specimens. The 3D root model built with VG StudioMAX 3.2 and ImageJ (Skeletonise 3D 
plugin) was used to determine the root length, root tortuosity and root plate tilt in field tests of biochar 
on maize crops (Ruan al., 2024).

The aim of this work was to develop a phytotoxicity testing algorithm consisting of automated plant 
measurement and primary data processing using ImageJ.

Materials and methods
To obtain photographic data and test the ImageJ software, two independent heavy metal toxic effect 

experiments were performed.
Acute toxicity experiments were conducted on 7-days red clover (Trifolium pretense L.) seeds by 

short–term exposure to various concentrations of copper chloride solution (5, 10, 15 mg/L or 5, 10, 15 × 
MAC of Cu2+)4. Drinking water served as a control and was used to prepare plant test solutions. Seeds 
(20 seeds) were germinated in Petri dishes under laboratory conditions: a temperature of 20 ± 2 °C and 
a light intensity of 250 lux. The analysis was made in triplicate.

1 GOST R ISO 18763-2019. Soil quality. Determination of the toxic effects of pollutants on germination and early growth of higher 
plants.
2 FR.1.31.2012.11560. Methodology for measuring the biological activity of humic substances using phytotesting (“Phytoscan”).
3 MR 2.1.7.2297-07. Methodological recommendations. Justification of the hazard class of industrial and consumer waste based 
on phytotoxicity ("Phytotest").
4 SanPiN 1.2.3685-21. Hygienic standards and requirements for ensuring the safety and (or) harmlessness of environmental 
factors for humans.
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Chronic toxicity data was obtained in barley (Hordeum vulgare  L.) experiments with a cadmium 
sulfate hydrate (3CdSO4 · 8H2O) as a reference toxicant. The toxicant solution was added to containers 
with sandy loam texture Albeluvisol. Pollution levels were referenced to the total metal forms APC (1 
mg/kg)5 in the absence of other environmental standards for cadmium in Russia. The resulting content 
was 19.2 ± 1.5 mg/kg (19.2 × APC). The control consisted of soil with no cadmium added. Plants grew 
for 60 days from May to July under a temperate continental climate (Kirov region, Russia). The soil was 
maintained near field capacity with a tap water. At the tillering stage, the subflag leaf was excised from 
20 plants in both the experimental and control groups. This leaf was selected due to the correlation of its 
area (Bosieva et al., 2021) and pigment content (Noskova et al., 2019) with grain yield, which is a key 
indicator of plant development.

Clover seedlings and barley leaves were photographed using a 20.1 MP smartphone camera. Image 
processing was performed using the ImageJ software6. The program was used to measure the root and 
shoot lengths of a clover seedling and the length and width of barley leaves. The area information was 
obtained through image segmentation. Results were presented as mean ± standard deviation. Data 
series were compared using one-way ANOVA analysis with STATGRAPHICS Centurion XV.I software 
(StatPoint Inc., USA).

Results and discussion

Primary data collection
The general algorithm for processing photographs and primary data includes the following steps:
1. ImageJ launch and image upload (File > Open).
2. Split of the input image into Red channel, Green channel and Blue channel (Image > Color > Split 

Channels) and selection of the channel with the highest contrast (minimize/close the windows with the 
less contrast).

3. Conversion of the image into a pure black and white bitmap (Process > Binary > Make Binary).
4. Setting the scale (Analyze > Set Scale) to convert pixels into needed measurement unit. Selection 

of an object of known size with the Straight Line tool, setting the scale & units of measurement in the 
pop-up window. Typically, a ruler is used as a scaling reference.

5. Use of the “Segmented Line” and “Magic Wand” tools to measure the length (Fig. 1A) and area 
(Fig. 1B) of the object. The user manually places marker points for length measurement by left-clicking. 
The number of marker points depends on the curvature of the object. Points must be placed on the 
curves. The object outline for area measurements is selected automatically. If necessary, the “Magnifying 
Glass” tool can be used to zoom in and out of the image.

6. Multiple images from a single experimental series are processed sequentially, and the unit scale 
is calibrated for each image. The data are automatically merged into the output table, which can be 
viewed by clicking the “Results” button (Window > Results).

7. Use of the “Analyze > Measure” command or the "Ctrl + M" combination to output the individual 
measurement results to the data table (Fig. 2).

8. Data export to Excel for further analysis.
The ImageJ output table shows the initial mathematical processing of the measurements, indicating 

the minimum and maximum values (Fig. 2A).
When processing the data in Excel, the extreme 5% of the values were excluded to obtain a 10% 

trimmed mean, which is more accurately represents the “average” of the dataset (Fig. 2B). A similar 
approach using trimmed means has been used in the analysis of morphological traits in some medical 
research (Gattavov et al., 2007).

5 SanPiN 1.2.3685-21. Hygienic standards and requirements for ensuring the safety and (or) harmlessness of environmental 
factors for humans.
6 Image J. Web page. URL: https://imagej.net/ij/ (accessed: 11.09.2025).



Evaluation of acute and chronic plant test results
The algorithm was approbated in two standard phytotoxicity experiments (Fig.  3, Table  1). It is 

known that small seeds are more susceptible to toxicity than larger ones because of the limited nutrient 
reserves (Terekhova et al., 2014). However, despite high sensitivity of small seeds, measuring their 
linear dimensions is difficult due to their small size and curved roots.

The standard deviation of automated root length measurements (excluding extreme values) 
ranged from 5% to 11% of the mean; for stem measurements, the standard deviation was 3% to 
7%. This represents a fairly good result for morphological parameters of plants. Low concentrations 
of copper (II) ions (5 and 10 × MAC) did not affect root length (p > 0.05), while high concentrations 
(15 × MAC) stimulated root growth. The observed copper effect (hormetic effect) is consistent with 
biological action data (Zhivukhina and Ertikeeva, 2019) and indicates the reliability of the results 
obtained using the software.

In chronic effects experiment with Cd, we measured both leaf area and linear parameters (leaf 
length and width at the widest part) (Table 1).

Chronic toxicity data showed high variability compared to acute one: standard deviations for linear 
parameters ranged from 11% to 21%, while for the area they reached 33%. This is an acceptable 
result for 20 samples (Lyubimov and Balina, 2005). All evaluated parameters demonstrated a trend 
toward increased responses to cadmium exposure, but no significant differences were found between 
the experimental variables. It is likely that higher concentrations would have revealed more consistent 
trends, but this was not part of the study's objectives.

Nevertheless, it can be said that the results obtained using the proposed algorithm are consistent 
with literature data. It is known that the phytotoxicity threshold for cadmium in soil can be quite high – 25 
mg/kg (Krylenkin et al., 2023). Even when the cadmium content in soil increases to 45 mg/kg, the toxic 
effects may occur only in roots, where cadmium accumulates at concentrations 10 times higher than in 
aboveground organs (Sterckeman and Thomine, 2020; Vassilev et al., 1998).

The main achievement of this experiment is the automated plant morphological data collection. 
Automated measurement of each plant part is the most promising approach because the manual 
process is labor-intensive. Measurement accuracy can be improved through increasing the number of 
measured objects.

Sheromov, A.M. et al., 2025. Ecosystem Transformation 8 (4), 205–214

Fig. 1. Placement of marker points on a clover seedling root for length measurement (A) and the resulting binary image for barley 
leaf area measurement (B) in ImageJ software.

A B
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Fig. 2. ImageJ data table (A), export to Excel (B) with clarification of the final result as M ± SD.

A B

Fig. 3. Effect of copper (II) ions on the root length (A) and shoot length (B) of a clover seedling.

Dose level Length, cm Width, cm Area, cm2

Control 10.9 ± 1.2 0.77 ± 0.09 4.8 ± 0.8

Cadmium 12.4 ± 2.5 0.81 ± 0.12 5.9 ± 1.9

Table 1. Size of H. vulgare subflag leaves under chronic cadmium exposure.

A B
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Conclusion
Using photographs to obtain plant information is not only convenient but also effective. Experimental 

data can be readily verified or reused for comparison with other subjects. We have demonstrated that 
the ImageJ-based processing of photographs of plant test objects can replace manual measurement 
with acceptable accuracy. This software can also assess certain plant features that are particularly 
difficult to measure manually. For example, image magnification and binarization allow us to measure 
the length of curved clover roots and determine the area of secondary flag leaves of barley.

Acute exposure of germinated clover seeds to copper (II) ions showed that 20 seeds per experiment 
in 3 replicates were sufficient to obtain reliable differences between different samples. At the same time, 
the chronic exposure accounted for the adaptation process and variability of individual characteristics of 
each seedling. That is why 20 specimens per experimental variant proved to be insufficient.

The novelty of this work lies in the detailed algorithmic approach for phytotoxicity experiments. 
The proposed algorithm is applicable to both acute and chronic experiments. The algorithm's broad 
applicability is ensured by its reliance on fundamental plant test parameters: seedling root and shoot 
length, and leaf area. These are the most commonly used evaluation metrics in plant testing worldwide.

The proposed algorithm for processing plant images and preprocessing in ImageJ has been shown 
to be effective in practice. It can be used to determine acute phytotoxicity of mediums and objects. 
Assessing chronic phytotoxicity is a more complex process and requires further methodological and 
statistical development.
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